
 

 ECT Lesson Plan: Patterns in the Periodic Table 
 

Lesson plan at a glance... 

Core subject(s) Science 
Subject area(s) Chemistry 
Suggested age 13 to 16 years old 
Prerequisites Familiarity with Google Sheets or extra time  
Time Preparation: 3 to 20 minutes 

Instruction: 100 to 175 minutes 
Standards Core Subject: NGSS 

CS: CSTA, Australia 
 

In this lesson plan… 
●​ Lesson Overview 

●​ Materials and Equipment 

●​ Preparation Tasks 

●​ The Lesson 

●​ Learning Objectives and Standards 

●​ Additional Information and Resources 

Lesson Overview 
In this lesson students study patterns in the organization of the periodic table supplemented by the use of spreadsheet 
functions. Students will begin to see how pattern recognition can be used to understand natural phenomena. The 
engagement level of the students can be increased by breaking them into groups and have them develop answers to 
discussion questions. At the end of this lesson students should have a better understanding of periodic table and begin to 
see how pattern recognition is a scientific skill.  
 
Educators can refer to the Teacher’s version of the Complete Periodic Trends sheet and the Complete Periodic Table 
sheet for an example of how spreadsheets should appear upon completion of this lesson. 
 

Materials and Equipment 
◻​ For the teacher:  

○​ Required: Presentation set-up 
■​ Internet-connected computer 

●​ Chrome browser (https://www.google.com/chrome/browser/desktop) recommended 
■​ Projector and projection screen or other flat projection surface 

◻​ For the student: 
○​ Required: Internet-connected computer (1 computer per student recommended) 
○​ Required: Google Sheets (https://docs.google.com/spreadsheets/) or other spreadsheet 

 

Preparation Tasks 

  Confirm that your computer is on and logged-in 1 to 5 minutes 

 Confirm that your projector is turned on and is projecting properly 1 to 5 minutes 

 Confirm that all students’ computers are turned on, logged-in, and connected to 
the Internet 

1 to 10 minutes 
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http://www.nextgenscience.org/next-generation-science-standards
http://csta.acm.org/Curriculum/sub/CurrFiles/Google_ExpCT_Standards_Crosswalk_Resources.pdf
http://www.australiancurriculum.edu.au/technologies/digital-technologies/curriculum/f-10?layout=1
https://docs.google.com/spreadsheets/d/19FAngFh2M41PcTwPxycuNDvefYIjHKAYzp0l3ZbTEEI/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1JNr_fkWegzRkNcI1TZDXewB0l1g57LJlv-StSOoIZx8/edit?usp=sharing
https://www.google.com/chrome/browser/desktop
https://docs.google.com/spreadsheets/


The Lesson 

Warm-up Activity: Exploring tables 15 to 20 minutes 

Activity 1: Grouping 15 to 30 minutes 

Activity 2: Discovering the pattern 20 to 40 minutes 

Activity 3: Melting points 35 to 55 minutes 

Wrap-up Activity: Summarizing 15 to 30 minutes 

 
Warm-up Activity: Exploring tables (15 to 20 minutes) 
Activity Overview: In this activity, students will explore the organization of two tables of the elements from the periodic 
table. Students will use pattern recognition to begin exploring the tables. 
 

Notes to the Teacher: 
The activities below suggest what you can tell and ask your students. In some cases you will want to lead the entire 
class as a whole. In other cases you will want to initiative the activity by putting instructions on a whiteboard or 
projecting them or perhaps distributing a handout and then roam around the class assisting students. You can increase 
your students’ engagement level by breaking your students into groups and having them jointly develop answers to the 
discussion questions. You can appoint students to serve in the role of “teacher”, recorder and/or reporter. 

 

Activity: 
Lead your students through the following activity: 
 
The periodic table is loaded with data on the properties of each element, organized into rows and columns. In 
two separate windows, open the Periodic Trends spreadsheet and the Periodic Table spreadsheet to begin to 
understand the organization of the elements. 
 
Q1: Study the data in the Periodic Trends spreadsheet. Which column does the spreadsheet appear to be 
sorted by? 
 
Q2: Study the Periodic Table spreadsheet. Describe how the atomic numbers are organized on the periodic 
table.  

 

Assessment:  
A1: The Periodic Trends spreadsheet is sorted by the Atomic Number column. 
 
A2: The atomic numbers display in order across the periodic table, increasing from left to right and top to bottom, with 
some exceptions in the sixth and seventh rows. 

 
 

Activity 1: Grouping (15 to 30 minutes) 
Activity Overview: In this activity, students will use the Periodic Trends spreadsheet to attempt to discover a relationship 
of atomic number to the three classifications of the elements. In doing so they will use pattern recognition. 
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https://docs.google.com/spreadsheets/d/1AQcKJymhfgaN3C7K3haR126Xy2Jf3qVx97JXyPuzReY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/10wEG5TR7WucUDdfFSKqpxp4DrU6flTJL2C3OKXb1TBo/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1AQcKJymhfgaN3C7K3haR126Xy2Jf3qVx97JXyPuzReY/edit?usp=sharing
https://docs.google.com/spreadsheets/d/10wEG5TR7WucUDdfFSKqpxp4DrU6flTJL2C3OKXb1TBo/edit?usp=sharing
https://docs.google.com/spreadsheets/d/1AQcKJymhfgaN3C7K3haR126Xy2Jf3qVx97JXyPuzReY/edit?usp=sharing


Activity:  
Take your students through the following steps: 

1.​ In the Warm-up Activity you saw how the atomic numbers are organized in the periodic table. In the 
following activity you will see how elements are grouped together in the table. 

2.​ Each element in the periodic table can be classified into one of the following groups: metal, nonmetal, 
or metalloid.  

3.​ While viewing the Periodic Trends spreadsheet choose Make a Copy in the Files menu to make your 
own copy of the spreadsheet.   

4.​ Follow the instructions to color code each element in your copy of the Periodic Trends spreadsheet, 
according to the three classifications.  

5.​ Conditional Highlighting in Google Docs: 
a.​ Highlight all the data in the Classification column 
b.​ Under the Format menu, choose Conditional Formatting  
c.​ Set the first button to Text is exactly 
d.​ In the first text box type nonmetal (must be spelled exactly as in the spreadsheet) 
e.​ Check the Background box 
f.​ Choose a new color for the background of all the nonmetals 
g.​ Click on +Add another rule  
h.​ Repeat the process for the metalloids using a different color 
i.​ By process of elimination, the elements that still have the original color coded are all metals 

 
Q1: Which type of element is most common, metal, nonmetal, or metalloid? Which is least common? 
 
Q2: Was it easier to identify the metals, nonmetals, and metalloids before or after we used the conditional 
highlighting tool?  

 

Assessment:  
A1: The majority of the elements are metals. 
 
A2: Answers may vary, however students should notice that once each type of element is highlighted with a different 
color it is easier to recognize which elements belong to which classification. 

 

Activity: 
Have your students do the following activity: 
 
The spreadsheet initially is sorted by atomic number. Follow these steps to re-sort it into groups of metals, 
nonmetals, and metalloids.  

a.​ Highlight all the data on the spreadsheet (do not include the headers in the first row).  
b.​ Go to the Data menu and select Sort range.  
c.​ Sort the Classification column (Column C) from a → z. 

 
Q3: Now that your data is sorted and highlighted, count how many metals, metalloids, and nonmetals are in the 
periodic table. 
 
Q4: List the atomic number of each metalloid. Is there a clear pattern in these numbers? 

 

Assessment:  
A3: metals - 83, metalloids - 9, nonmetals - 18  
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A4: Atomic numbers of metalloids: 5, 14, 32, 33, 51, 52, 84; there is no clear pattern to the atomic number of 
metalloids. 

 

Notes to the Teacher: 
Sorting and color coding data makes it easier to visualize the elements. 

 

Activity 2: Discovering the pattern (20 to 40 minutes) 
Activity Overview: In this activity, students will use the periodic table format to discover patterns in the three categories 
of elements. This activity will continue to use pattern recognition. 
 

Activity:  
Have your students do the following: 

1.​ In a spreadsheet list it is difficult to identify any patterns between the atomic number and the 
classification of an element into metal, nonmetal, and metalloid. However, when we study the 
arrangement of these elements in the periodic table we begin to notice a connection between an 
element’s location and its classification. 

2.​ While viewing the Periodic Table spreadsheet choose Make a Copy in the Files menu to make your own 
copy of the spreadsheet.   

3.​ Look to your copy of the Periodic Trends spreadsheet to identify the atomic number of each metalloid. 
Change the background of the cells containing the metalloids in your copy of the Periodic Table 
spreadsheet to match the color that you used for metalloids on the Periodic Trends spreadsheet. 
Repeat this process for the nonmetals in the periodic table. 

4.​ Instructions for color coding the Periodic Table 
a.​ On the Periodic Table sheet, highlight a cell that contains a metalloid. 
b.​ In the toolbar above the periodic table, click on the Text background color button and choose 

the color that you used for metalloids in the Periodic Trends sheet. (see below) 
 

 
 

c.​ Repeat the process until all the metalloids are the same color on the periodic table. 
d.​ Repeat the process for the nonmetals, using a the color you chose for nonmetals in the Periodic 

Trends sheet. 
 
Q1: Describe the location of the metals, metalloids, and nonmetals on the periodic table. 

 

Assessment:  
A1: The nonmetals are located in the upper right hand corner of the table, followed to the left/below by the metalloids, 
and the remainder of the table is filled with metals. 

 

 
 ECT: Patterns in the Periodic Table​ ​ ​ ​ ​ ​ ​ ​ ​ ​    4 of 7 
 

https://docs.google.com/spreadsheets/d/10wEG5TR7WucUDdfFSKqpxp4DrU6flTJL2C3OKXb1TBo/edit?usp=sharing


 

Activity 3: Melting points (35 to 55 minutes) 
Activity Overview: In this activity students will look for a relationship between the melting point of an element and its 
placement in the periodic table. All melting points are in kelvin. Students will discover a pattern relating melting point to 
element category as well as exceptions to the pattern. 
 

Notes to the Teacher: 
Organizing the data by melting point allows us to look for more patterns in the arrangement of elements in the periodic 
table. Once students understand that there are patterns in the properties of the elements in the first column and those 
in the last few columns they can begin to explore the relationship to understand why. 

 

Activity: 
Walk through the following with your students: 
In the Periodic Trends spreadsheet, highlight all of the data and sort it by melting point  

(Data→ Sort range→ Column D). 
 

Q1: What element has the lowest melting point? Which has the highest melting point? 
 
Q2: Which type (classification) of elements tend to have the lowest melting points? 
 
Q3: Does this pattern always hold? If not, name at least two exceptions to the general trend. 
 
To easily identify the elements with the lowest melting points on the Periodic Table spreadsheet, choose a new 
font color for the atomic number of all elements whose melting temperature is less than 500 degrees. One 
partner should read these numbers from the Periodic Trends spreadsheet while the other changes the font 
color of these elements on the Periodic Table spreadsheet. If you find that these elements are grouped 
together, highlight them in groups to save time. 

 
Q4: Describe the location of the elements with these melting points. Are they scattered randomly across the 
table or are they clustered together? 
 
Q5: Which column of the table contains metals whose melting temperatures are closest to the melting 
temperatures of most nonmetals? 
 
Q6: Which nonmetal is an outlier with a melting temperature far above 500 degrees? Does this element border 
the metalloids or is it surrounded by other nonmetals? 

 

Assessment: 
A1: Helium is at the top of the sheet with the lowest melting point, and at the end of the sorted list we have carbon with 
the highest recorded melting point. 
 
A2: Most of the nonmetals are clustered at the top of the list with the lowest melting points, although there are several 
exceptions.  
 
A3: No, although most nonmetals have lower melting points than most metals and metalloids, there are several 
exceptions. For example the metal Cs (cesium) has a lower melting point than the nonmetal S (sulfur), and the 
nonmetal C (carbon) has one of the highest melting temperatures of all. 
 
A4: The elements with the lowest melting temperatures are clustered in one group on the right hand side of the table 
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and then in another group on the left hand side. Students should notice that if we wrapped the periodic table around a 
cylinder these elements would all be grouped together.  
 
A5: The elements in the first column of the left hand side of the table also have relatively low melting points, even 
though they are metals. 
 
A6: Carbon is a nonmetal with a high melting temperature. It borders the metalloids; we see properties begin to shift as 
we get closer to different categories of elements. 

 
 

Wrap-up Activity: Summarizing (15 to 30 minutes) 
Activity Overview: In this activity, students will review some key patterns in the periodic table. They will discuss how 
atomic number, metals, metalloids, nonmetals and melting temperature are arranged in the periodic table. Students will 
continue to use pattern recognition.   
 

Notes to the Teacher: 
While you can engage the classroom as a whole with the discussion question below, it will probably be more effective if 
you divide the students into groups and ask one student in each group to play the role of the teacher asking the 
question, one to take notes about the answers and the rest of the students to suggest answers to the question. After the 
time is up, the student taking notes can summarize the group’s conclusions. 

 

Activity:  
Prompt discussion with the following: 
Summarize all of the patterns/trends in how the elements are grouped in the periodic table. Consider the 
atomic numbers, the classification of the elements, and the melting points. 
 
Answers will vary, however students should note the following: 

●​ Atomic number increases across rows (left to right) and down columns 
●​ Elements are grouped together as metals, metalloids, and nonmetals 
●​ Melting temperatures are lowest in the top right hand side of the table, and remain relatively low in the first 

column on the left hand side of the table as well. 
 
 

Learning Objectives and Standards 

Learning Objectives Standards 

LO1: Students should be able to predict generally 
where in the periodic table metals, metalloids and 
nonmetals are found. 

Core Subject 
NGSS PE HS-PS1-1: Use the periodic table as a model to predict 
the relative properties of elements based on the patterns of 
electrons in the outermost energy level of atoms. 
 
Computer Science 
AUSTRALIA 10.4 (Collecting, managing and analyzing data): 
Analyse and visualise data to create information and address 
complex problems; and model processes, entities and their 
relationships using structured data 
CSTA L3B.CT.9: Analyze data and identify patterns through 
modeling and simulation. 
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LO2: Students should be able to explain patterns 
of melting points of elements with reference to the 
periodic table. 

Core Subject 
NGSS PE HS-PS1-1 
 
Computer Science 
CSTA L3B.CPP.7: Use data analysis to enhance understanding of 
complex natural and human systems. 

 
 

Additional Information and Resources 
Lesson Vocabulary 

Term Definition For Additional Information 

Periodic table A tabular chart of the chemical elements according to 
their atomic numbers so that elements with similar 
properties are in the same column. 

http://en.wikipedia.org/wiki/Periodic_table 

Metal Any of a number of chemical elements in the periodic 
table that form a metallic bond with other metal atoms; 
generally shiny, somewhat malleable and hard, often a 
conductor of heat and electricity. 

http://en.wikipedia.org/wiki/Metal 

Metalloid An element, such as silicon or germanium, intermediate 
in properties between that of a metal and a nonmetal; 
especially one that exhibits the external characteristics of 
a metal, but behaves chemically more as a nonmetal. 

http://en.wikipedia.org/wiki/Metalloid 

Nonmetal An element, such as phosphorus or chlorine, that does 
not have the chemical or physical properties of a metal 

http://en.wikipedia.org/wiki/Nonmetal 

Melting point The temperature at which the solid and liquid phases of a 
substance are in equilibrium; it is relatively insensitive to 
changes in pressure. 

http://en.wikipedia.org/wiki/Melting_point 

Kelvin A unit for a specific temperature on the Kelvin scale. http://en.wikipedia.org/wiki/Kelvin 
 

Computational Thinking Concepts 

Concept Definition 

Pattern Recognition  Breaking down data, processes or problems into smaller, manageable parts. 
 

Administrative Details 

Contact info For more info about Exploring Computational Thinking (ECT), visit the ECT website 
(g.co/exploringCT) 

Credits Developed by the Exploring Computational Thinking team at Google and reviewed by K-12 
educators from around the world. 

Last updated on 06/30/2015 

Copyright info Except as otherwise noted, the content of this document is licensed under the Creative Commons 
Attribution 4.0 International License, and code samples are licensed under the Apache 2.0 License. 
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